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Software License Agreement 
This Software License Agreement (“License Agreement”) is a legal agreement between you (either an 
individual or a single entity) and Serif (Europe) Ltd. (“Serif”) for the accompanying software product, 
which includes computer software and may include associated media, printed materials, and “online” 
or electronic documentation (the “Software Product”). By installing, copying, or otherwise using the 
Software Product, you agree to be bound by the terms of this License Agreement. If you do not agree 
to the terms and conditions of this License Agreement, do not install or use the Software Product; you 
may, however, return it to your place of purchase for a full refund. 
THANK YOU FOR LICENSING THE USE OF THE SOFTWARE PRODUCT. IT IS IMPORTANT THAT YOU (THE "LICENSEE") 
READ THIS NOTICE CAREFULLY. THESE ARE THE ONLY TERMS AND CONDITIONS APPLICABLE TO YOUR RIGHTS 
WITH RESPECT TO THE SOFTWARE PRODUCT. THE SOFTWARE PRODUCT IS PROTECTED BY COPYRIGHT LAWS AND 
INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY LAWS AND TREATIES. THE 
SOFTWARE PRODUCT IS LICENSED, NOT SOLD. 

  

1. GRANT OF LICENSE 

Serif hereby grants to Licensee a personal, non-exclusive, non-
transferable license (a "License") to use one (1) copy of the 
Software Product, including any updates thereto, and 
accompanying documentation, if any, provided by Serif, 
according to the terms set forth below. If the Software Product is 
being provided to Licensee as an update or upgrade to software 
which Licensee has previously licensed (such software referred to 
as the "Prior Software"), then Licensee agrees to destroy all 
copies of the Prior Software within thirty (30) days after opening 
this package except for one backup copy of the Prior Software. 

 

2. SCOPE OF USE 

You may install and use one copy of the Software Product, on a 
single computer. The primary user of the computer on which the 
Software Product is installed may make a second copy for his or 
her exclusive use on a portable computer. Licensee may also store 
or install a copy of the Software Product on a storage device, such 
as a network server, used only to install or run the Software 
Product on other computers over an internal network; however, 
you must acquire and dedicate a license for each separate 
computer on which the Software Product is installed or run from 
the storage device. A license for the Software Product may not be 
shared or used concurrently on different computers. 

 

3. LICENSE PAK 

If you have acquired this LICENSE AGREEMENT in a Serif 
License Pak, you may make the number of additional copies of 
the computer software portion of the Software Product as 
authorized in the Serif License Pak, and you may use each copy 
in the manner specified above. You are also entitled to make a 
corresponding number of secondary copies for portable computer 
use as specified above. 

 

4. PROHIBITIONS 

You may not: modify, prepare derivative works from, translate, 
reverse engineer, decompile, disassemble or otherwise derive 
source code from the Software Product (except to the extent that 
such acts are expressly permitted by applicable law 
notwithstanding this limitation); copy the Software Product 
(except as provided above) or the accompanying documentation; 
rent, transfer, disclose, make available or grant any rights in the 
Software Product (including any accompanying documentation) 
in any form to any person without the prior written consent of 
Serif; remove any proprietary notices, labels, or marks on the 
Software Product (including any accompanying documentation); 
use the Software  

Product in any manner that infringes the intellectual property or 
other rights of another party; or use the Software Product to 
provide on-line or other database services to any other person. 

 

5. RETENTION OF RIGHTS; TERMINATION 

This License Agreement does not constitute a sale. All title, trade 
secrets, copyrights, patents and other intellectual rights to the 
Software Product, its accompanying documentation and any copy 
made by Licensee remain with Serif, and Licensee hereby agrees 
to preserve and acknowledges the foregoing. Licensee further 
agrees and acknowledges that the Software Product and all copies 
thereof are Serif’s exclusive property and constitute a valuable 
trade secret of Serif. Licensee further agrees and acknowledges 
that unauthorized copying of the Software Product or the 
accompanying documentation, or failure to comply with any of 
the provisions hereof (each, a "Terminable Event"), will result in 
automatic termination of this License. In the event of a violation 
of this License by Licensee, Serif reserves and shall have 
available all legal remedies. 

 

6. TERM OF LICENSE FOR TRIAL VERSION 
SOFTWARE 

The License pertaining to a trial version of the Software Product 
(a "Trial Version") shall expire in accordance with the terms as 
set forth in the installation process for the Trial Version along 
with the designated trial period as set forth in the trial program.  
 
7. LIMITED WARRANTY AND DISCLAIMER 

Serif warrants that, for a period of ninety (90) days after delivery, 
the diskettes or CD-ROMs on which the software included in the 
Software Product is furnished will, under normal use, be free from 
defects that prevent Licensee from loading the Software Product 
on a computer. Serif’s entire liability and Licensee’s exclusive 
remedy under this warranty will be, at Serif’s option, to (a) use 
reasonable commercial efforts to attempt to correct or work around 
errors, or (b) to replace the Software Product with functionally 
equivalent Software Product, on diskettes or CD-ROM, as 
applicable or (c) return the price paid for the Software Product, in 
each case upon return of the Software Product to Serif together 
with a copy of your receipt for the purchase thereof. This Limited 
Warranty is void if failure of the Software Product or hardware has 
resulted from accident, abuse, or misapplication. Any replacement 
Software Product will be warranted for the remainder of the 
original warranty period or thirty (30) days, whichever is longer. 
Outside the United States, neither these remedies nor any product 
support services offered by Serif are available without proof of 
purchase from an authorized non-U.S. source. The Software 
Product is licensed to you on an "as is" basis without any warranty 
of any nature. 
 



8. NO OTHER WARRANTIES 

Except for the above express limited warranties, Serif and its 
suppliers make and licensee receives no warranties or conditions, 
or terms, express, implied, statutory, or in any communication 
with licensee. To the maximum extent permitted by applicable 
law, Serif and its suppliers disclaim all other warranties and 
conditions, either express or implied, including, but not limited 
to, implied warranties of merchantability, fitness for a particular 
purpose, title and non-infringement, with regard to the software 
product and the provision of or failure to provide support 
services. Licensee shall be solely responsible for the selection, 
use, efficiency and suitability of the software product and serif 
shall have no liability therefor. Serif shall have no liability for, 
nor obligation to indemnify licensee regarding actions alleging 
the infringement of proprietary rights by the software product. 
Serif does not warrant that the operation of the software product 
will be uninterrupted or error free or that the software product 
will meet licensee’s specific requirements. The Limited Warranty 
gives you specific legal rights. You may have others, which vary 
from state/jurisdiction to state/jurisdiction. 
 
9. LIMITATION OF LIABILITY 

In no event will Serif or its suppliers be liable for loss of data, 
corruption, lost profits, cost of cover, or other special, incidental, 
punitive, consequential, or indirect damages arising from the use 
of the software product (including any accompanying 
documentation), however caused and on any theory of liability. 
This limitation will apply even if Serif or an authorized 
distributor has been advised of the possibility of such damage. In 
no event will Serif’s liability exceed the amount paid for the 
software product. Licensee acknowledges that the amounts paid 
by licensee for the software product reflect this allocation of risk. 
Some states or other jurisdictions do not allow the exclusion or 
limitation of liability for incidental or consequential damages, so 
the above limitations and exclusions may not be applicable in 
certain instances. None of the above affects the statutory rights of 
licensees residing in the United Kingdom. 
 
10. NOT FOR RESALE SOFTWARE 

If the Software Product is labeled “Not for Resale” or “NFR,” 
then, notwithstanding section 1 of this License, your use of the 
Software Product is limited to use for demonstration, test, or 
evaluation purposes.  
 
11. NO RENTAL; OTHER TRANSFERS 

You may transfer this License to another computer or workstation 
only on a permanent basis (that is, with no intent to transfer 
again) provided the computer, workstation, or other digital 
electronic device from which you have transferred this License no 
longer accesses or otherwise utilizes the Software Product, and 
the Software Product is used in accordance with the terms of this 
License Agreement.  
 
12. TERMINATION 

You may terminate this License Agreement at any time. Serif 
may terminate this License Agreement if you fail to comply with 
the terms and conditions of this License Agreement. In either 
event, you must destroy all copies of the Software Product.  
 
13. UPGRADE 

If this License is an “Upgrade,” you must have a valid license for 
the Prior Software for this License Agreement to be valid, and 
this License Agreement must be used to replace such license for 
the Prior Software. The total number of license “Upgrades” you 
may acquire may not exceed the total number of computers, 

workstations, or other digital electronic devices that were 
licensed to access or otherwise utilize the Software Product at the 
time you upgraded the Software Product. 
 
14. GUIDELINES FOR THE USE OF DIGITAL CONTENT 
IMAGES 
This product contains numerous clipart and photo images 
(collectively referred to as the “Images”) which are either owned 
by Serif or licensed from a third party. As a user of this product 
you are free to use, modify, and publish the Images as you wish 
subject to the restrictions set out below. If you are uncertain as to 
whether your intended use complies with the guidelines set out 
below, we recommend that you seek the advice of your own 
attorney or legal counsel. 
 
A. YOU MAY, subject to any restrictions set out below: 
1. Incorporate any Image(s) into your own original work and 
publish, display, and distribute your work in any media. You may 
not, however, resell, sublicense, or otherwise make available the 
Image(s) for use or distribution separately or detached from a 
product or Web page. For example, the Image(s) may be used as 
part of a Web page design, but may not be made available for 
downloading separately or in a format designed or intended for 
permanent storage or reuse by others. Similarly, clients may be 
provided with copies of the Image(s) (including digital files) as 
an integral part of a work product, but may not be provided with 
the Image(s) or permitted to use the Image(s) separately or as part 
of any other product; 
2. Make one (1) copy of the Image(s) for backup or archival 
purposes. 
 
B. YOU MAY NOT: 
1. Create scandalous, obscene, defamatory, or immoral works 
using the Image(s) nor use the Image(s) for any other purpose 
prohibited by law; 
2. Use or permit the use of the Image(s) or any part thereof as a 
trademark or service mark, or claim any proprietary rights of any 
sort in the Image(s) or any part thereof; 
3. Use the Image(s) in electronic format, on-line, or in multimedia 
applications unless (a) the Image(s) are incorporated for viewing 
purposes only and (b) no permission is given to download and/or 
save the Image(s) for any reason; 
4. Rent, lease, sublicense, or lend the Image(s), or a copy thereof, 
to another person or legal entity. You may, however, transfer all 
your license to use the Image(s) to another person or legal entity, 
provided that (a) you transfer the Image(s) and this License, 
including all copies (except copies incorporated into your work 
product as permitted under this License), to such person or entity, 
(b) that you retain no copies, including copies stored on a 
computer or other storage device, and (c) the receiving party 
agrees to be bound by the terms and conditions of this License; 
5. Use any Image(s) except as expressly permitted by this 
License. 
 

15. MISCELLANEOUS 
This Agreement shall not be governed by the 1980 U. N. 
Convention on Contracts for the International Sale of Goods; 
rather, this Agreement shall be governed by English law. This 
Agreement constitutes the entire agreement between Serif and 
Licensee and supersedes all prior agreements, understandings, 
communications, advertising, proposals or representations, oral or 
written, by either party. If any provision of this Agreement is held 
invalid or unenforceable, such provision shall be revised to the 
extent necessary to cure the invalidity or non-enforceability, and 
the remainder of this Agreement shall continue in full force and 
effect. This Agreement shall be amended only by an executed 
writing by authorized representatives of both parties. 



How to contact Serif 
The Software Center 
13 Hampshire Drive, Unit 12, Hudson NH 03051 

Main   (603) 889-8650 
Registration  (800) 794-6876 
Single Unit Sales  (800) 55-SERIF or 557-3743 
Technical Support (603) 886-6642 
Customer Service  (800) 489-6720 
General Fax  (603) 889-1127 

Technical Support E-mail support@serif.com 

European office (UK, Europe): 
The Software Centre 
PO Box 2000, Nottingham, NG11 7GW, UK 

Main   (0115) 914 2000 
Registration  (0500) 454 645 
Sales   (0800) 376 7070  
Technical Support* (0115) 914 9090  
Customer Service* (0115) 914 9090 
General Fax  (0115) 914 2020  

*Local rate (UK only) (0845) 345 6770 

Technical Support E-mail support@serif.co.uk 

Online 
Visit us on the Web at http://www.serif.com 
Serif newsgroups  news://news.serif.com 

International 
Please contact your local distributor/dealer. For further details please 
contact us at one of our phone numbers above. 
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2    Welcome 

Welcome 
You’re about to discover an indispensable tool for the wired world. 

We’re surrounded by images, deluged by media messages. They come at 
us in all forms, from every direction... as e-mail attachments, clip art, 
digital camera snaps and scans. We’re awash in an alphabet soup of  
JPEGs, MPEGs and GIFs. WebManager was created to help bring order 
to this chaos—to let you take control of your own media domain!  

Not only will WebManager help you to catalog and organize the media 
files you already have—the efficiency boost will bring added enjoyment 
as you build up your collection. Album thumbnails arranged in windows 
mean you can browse your holdings visually, with instant preview 
capabilities. And produce your own galleries for Web or disk-based 
presentation with a few clicks of the mouse. 

We’re proud to present this latest addition to the Serif family! 

About the Companion 
This Companion is your guide to getting started and getting results with 
WebManager—from initial installation through advanced tips and 
examples. 

1 Welcome. Read on for a feature summary—a checklist of the 
capabilities in store for you.  

2 Getting Started. How to get up and running, and select the 
preferences that are right for the task at hand. 

3 Managing Media Files. The basics of browsing, previewing, and 
organizing your collection using WebManager albums. 

4 Acquiring Media Files. How to collect images from a digital 
camera or scanner, and media from anywhere on the Web.  

5 Presentations and Output. Share your favorite images in print 
form or via Web galleries. 
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What You Can Do with WebManager 1.0... 
Here’s a quick summary of what’s in store for you. Check the Table of 
Contents in online Help for direct links from each feature to its detailed 
coverage.  

♦ Browse and Manage Media Files 
Use familiar folder navigation to see what’s stored in your archives. 
Preview not just photos, but animations, videos! Move, copy, delete 
files, and bring them under control.  

♦ Create Your Own Albums 
Cut through the clutter using thumbnail shortcuts. Use albums to 
catalog files stored in any folder. Assign any media file to as many 
albums as you wish. Annotate albums with your own comments and 
notes. 

♦ Download Web Media  
Just point WebManager at a target Web page and tell it how far to 
roam. Then sit back and watch it explore, collecting images or other 
media files according to your exact specifications! 

♦ Publish Web Galleries 
Showcase your images and multimedia files in HTML format... 
either on your own Web site or saved to disk. It’s as easy as picking 
a preferred layout—then customize if you like—WebManager does 
the rest! 

Registration, Upgrades, and Support 
If you see the Registration Wizard when you launch WebManager, please 
take a moment to complete the registration process. Just call Serif toll-free 
and provide the installation number and code shown. (You can also 
choose Registration Wizard... from the Help menu.) We’ll give you a 
personalized registration number in return. Remember, if you need 
technical support please contact us. We aim to provide fast, friendly 
service and knowledgeable help. 
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Installation 

What you need to run WebManager 
If you need help installing Windows or setting up peripherals, refer to 
Windows documentation and help (see below).  

♦ IBM compatible Pentium PC with CD-ROM drive and mouse (or 
other Microsoft compatible pointing device)  

♦ Microsoft Windows® 95, 98, 98 SE, Me, 2000, NT® 4.0, or XP 
operating system 

♦ 16MB (Windows 95/98), 24MB (Windows 98 SE, Me), 32MB 
(Windows NT 4.0), or 64MB (Windows 2000, XP) RAM 

♦ 10MB (recommended install) free hard disk space 

♦ SVGA display (16-bit color, 800 x 600 resolution) or higher 

Optional components include: 

♦ Windows-compatible printer 

♦ Internet account and connection required for Web Publishing 
features and accessing online resources 
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What you need to know 
If you’re new to Windows computing, you will find it much easier if, 
before installing and using WebManager, you spend a little time becoming 
familiar with the operating environment.  

� From the Windows desktop, click the Start button at the lower left 
and choose Help.  

First-time install 
To install Serif WebManager, simply insert the CD-ROM into your CD-
ROM drive. The AutoRun feature automatically starts the Setup process. 
(If it doesn’t, follow the manual install procedure described below.) 

Just answer the on-screen questions to install the program.  

Manual install/re-install 
To re-install the software or to change any part of the installation at a 
later date, select Settings/Control Panel from the Windows Start menu 
and then click on the Add/Remove Programs icon. Make sure the 
correct CD-ROM is inserted into your CD-ROM drive and then simply 
follow the on-screen instructions. 
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Starting WebManager 
Once WebManager has been installed, you’re ready to start. Setup adds a 
Serif WebManager 1.0 icon to the Programs submenu of the Windows 
Start menu. 

Use the Windows Start menu to launch WebManager. The program 
opens with all its windows on display, and a sample album open in the 
center of the screen. Your view will appear something like this: 

 

Here’s a recommended learning sequence: 

1 First, take a moment to familiarize yourself with each of the 
WebManager windows by name. This will give you a general idea of 
what each window’s for. 

2 To begin learning about WebManager tools and menus, just move 
the mouse pointer around the screen. Watch the Hintline at the 
bottom of the screen for capsule descriptions of each feature.  

3 Choose WebManager Help from the Help menu to see what’s 
available in online help. The opening screen provides a convenient 
visual reference. Simply click a topic on the left to learn about any 
feature. 

4 For illustrated, step-by-step coverage of WebManager tools and 
functions, peruse the remaining Companion chapters at your leisure. 

Explorer 
window 

Browser 
window 

Album 
window 

Preview 
window 
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Setting WebManager Preferences 
You can refine your WebManager environment even further using global 
program settings stored as preferences. For example, you can change the 
background color of windows—or even employ an image as a backdrop. 
Thumbnail size, description text, and tooltips are all under your control.  

To view or change general settings and non-album window options, 
choose General Preferences... from the File menu. To set options for a 
particular album window, select the window and choose Album 
Preferences... from the File menu.  

See the chart that follows for a handy summary of program options. 

Preference reference 
 

Use this tab of File/General 
Preferences... 

To set these global options... 

Display Browser colors, optional background image 

Background colors for fullscreen view, Preview 
window 

Thumbnail Size Width and height of Browser thumbnails  

Thumbnail Text Wording style of Browser thumbnail captions 

Tooltips Wording style of Browser tooltips 

Misc Thumbnail animation preferences 

Timeout on page downloading 

Which file types to display in Browser window 

Display the last album at run-up (new session) 

Web Publishing Metadata options, non-Web image options 

 

Use this tab of File/Album 
Preferences... 

To set these options for a specific album... 

Display Window colors, optional background image 

Thumbnail Size Width and height of thumbnails  

Thumbnail Text Wording style of thumbnail captions 

Tooltips Wording style of tooltips 
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The Explorer window and the Browser window work together to help 
you locate images and other media files stored in folders on local or 
network drives. Simply select any folder to view a thumbnail catalog—a 
set of small pictures representing the media files in the folder. Albums 
appear in their own windows. Each album is a collection of thumbnail 
shortcuts saved as a separate WebManager document. Using simple drag-
and-drop, you can build albums to keep track of your media files 

Using either Browser or album thumbnails, you can preview media 
content, view file information, and carry out file operations (for example, 
delete original files you no longer need). By selecting thumbnails or 
entire windows, you can designate which files to include in Web galleries 
and other output. 

 

Browsing Folders 
There are lots of ways to select a folder and view its contents. First 
display the Browser window, then navigate to the folder using any of 
these methods: 

♦ Use the Explorer window’s  tab 
This is the most common way: Simply select the folder name from 
the hierarchical “tree” view.  

♦ Use toolbar buttons 

Click the  Back and  Forward buttons to navigate through 
the visited folder sequence. 

Click the  Up button to move up through the folder hierarchy. 

♦ Use the Address toolbar  
Type the folder’s full path 
and press Enter. You can 
also click the down arrow 
button and select any 
previously visited folder 
from the drop-down list. 



Managing Media Files    13 

 

 

♦ Jump from an album thumbnail  
Right-click a thumbnail in an open 
album window and choose Browse 
to Folder. 

 

You can select and arrange Browser thumbnails as described in the next 
section, and use them to carry out various operations on the original 
media files, as covered in the “File Management” section. 

Selecting and Arranging Thumbnails 
Each thumbnail in the Browser window represents an actual media file, 
while the thumbnails in WebManager albums (see the next section) are 
shortcuts to the files. Still, the techniques for manipulating both kinds of 
thumbnails are the same. 

 
 Browser thumbnail Album thumbnail 

 
Do this... To... 

Click Select a thumbnail 

Ctrl-click Select multiple thumbnails 

Shift-click Select a range of thumbnails 

Press Ctrl+A  

Choose Edit/Select All 

Select all thumbnails in the window 

Press Ctrl+D 

Choose Edit/Select None 

Deselect all thumbnails in the window 

Choose File/Invert 
Selection 

Toggle the state of all thumbnails in the 
window. (Selected thumbnails are deselected, 
and vice versa.) 

 

� HINT: You can also step through the thumbnails in a window using 
the arrow keys on the keyboard. 
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WebManager thumbnails are designed to help you make the most of your 
screen space. When you mouse over a thumbnail, the file’s format and 
path appear in a popup tip. To change the size of the displayed 
thumbnails, hover the mouse pointer over any one thumbnail until you 
see the small drag handle in the thumbnail’s lower right corner. Drag the 
handle in or out to adjust the thumbnail to a desired size, then release the 
mouse button. All thumbnails in the window will adjust to the indicated 
size. 

 
Drag the handle...  ...to resize 

Choose File/Album Preferences... to customize which file information 
appears in album tips and thumbnail captions, or to set thumbnail size 
quantitatively. Use File/General Preferences... to alter comparable 
settings for the Browser window. The General Preferences Misc tab also 
includes global settings for thumbnails derived from animated 
multimedia files such as GIF and MPEG, and lets you customize which 
file types are shown in the Browser. 

You can quickly sort the thumbnails in a window according to attributes 
like file name, size, and so on. Right-click any thumbnail and choose 
Sort. Then choose an attribute and the sort order (Ascending or 
Descending) from the submenu. 

And you can rearrange the sequence of thumbnails by hand. Select one or 
more thumbnails and drag to a new location in the window. Adjacent 
thumbnails shrink slightly to help you locate the “drop zone.” 

 

Note that resizing, rearranging, or sorting thumbnails has no effect on the 
original media files, even in the Browser window. 
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Building Albums 
Each album is a collection of thumbnails saved as a separate 
WebManager document in Serif’s .SMA format. While the Browser 
window lets you view the actual media files stored in a single folder, 
album thumbnails are shortcuts to media files. To create a shortcut, you 
simply drag from a Browser window thumbnail into an album window. 
One album can catalog files stored in diverse locations, and the same file 
can be represented in any number of albums! Albums are a great way to 
organize your media files into categories and groupings that make sense 
to you, without moving the actual files around.  

Album thumbnails are shortcuts, but you can use them just like Browser 
window thumbnails to preview media content, view file properties, and 
delete original files you no longer need. And as with Browser thumbnails, 
you can print images, publish Web albums, and much more using album 
thumbnails.  

Albums are also ideal for images you’ve collected from the World Wide 
Web using WebManager (see Chapter 4) or storing digital camera 
(TWAIN) images. 

Initially, WebManager displays a window for the sample album, 
SAMPLE.SMA (shown here tiled, with its titlebar visible). 

 

The basic way to create a new album is to choose New... from the File 
menu. Another very convenient method is to select and copy one or more 
thumbnails to the Clipboard, then choose Paste into New Album from 
the Edit menu (Ctrl+Shift+V). This creates a new album containing just 
the copied thumbnail(s).  
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� NOTE: You also have the option of creating a new album as part of 
other operations—such as when downloading. 

To open an existing album, choose Open... from the File menu, or (for a 
recently used album) choose its name directly from the File menu. You 
can even double-click an album’s thumbnail in the Browser window to 
open it! 

To close an open album, click its  Close button or choose Close from 
the file menu. To save an album in Serif’s .SMA format, choose Save... 
from the File menu. (Chose Save As... to save under a different name.) 

� HINT: Consider saving your albums into a common folder. This will 
make opening them more convenient.  

You can have one or more albums open at a time in the rectangular, 
background region of the workspace. To tile album windows within the 
background region, choose Tile Album Windows from the View menu.  

OK, now that you have an album window, how can you use it to catalog 
your media files? The short answer is, simply by creating thumbnails in 
the album window to represent the media files. Since these album 
thumbnails are just shortcuts, you can select, move, copy, and paste them 
between album windows to your heart’s content—creating new file 
groupings as needed.  

Drag and drop is the simplest approach. Open the destination album 
window, then (either in the Browser window or another album window) 
select one or more thumbnails as described in “Selecting and Arranging 
Thumbnails.” Just drag the thumbnail(s) into the 
destination window and drop when you see the drop 
cursor.  
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Album window operations  
Here’s a quick summary of commands for manipulating album 
thumbnails (RC   denotes that the item is also available from the 
thumbnail’s right-click menu):  

Using drag and drop 
Dragging from the Browser window creates a new thumbnail 
shortcut to the original media file; it doesn’t disturb the original 
file. Dragging from one album window to another moves the 
thumbnail; to copy the thumbnail, hold down the Ctrl key while 
dragging. Dragging an album thumbnail into the Browser 
window (or a folder on the Explorer window’s Folders tab) 
copies the original file to that folder. 

Edit/Cut (Shortcut: Ctrl+X) 
In an album window, deletes the selected thumbnail(s) and 
places a copy on the Clipboard. 

Edit/Copy (Shortcut: Ctrl+C) 
In an album window, copies the selected thumbnail(s) to the 
Clipboard.  

Edit/Paste into Album  (Shortcut: Ctrl+V)   
Inserts one or more album thumbnail(s) from the Clipboard into 
the selected album window. You can also select the thumbnail(s) 
and drag into an album window while holding down the Ctrl key. 
NOTE: If you’ve copied a file from the Browser window, Paste 
into Album adds an album thumbnail, not a copy of the file. 

Edit/Paste into New Album (Shortcut: Ctrl+Shift+V) 
Creates a new album window and inserts one or more album 
thumbnail(s) from the Clipboard into the new window.  

Edit/Delete Thumbnail(s)  RC   (Shortcut: Delete) 
In an album window, deletes the selected thumbnail(s), not the 
original files. 
NOTE: In the Browser window, pressing Delete is the same as 
Edit/Delete File(s). 
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One other useful command, Browse to Folder, is only available on the 
right-click menu from album thumbnails. Suppose you’ve located an 
interesting album thumbnail, and then want to view other media files that 
are stored in that particular file’s parent folder—but the Browser window 
is currently showing some other folder’s contents. You can right-click the 
album thumbnail and choose Browse to Folder to “synch” the Folders 
tab, Browser window, and Address bar to the parent folder. Note that the 
correspondence is temporary; the Browser and album views will continue 
to operate independently of one another. 

File Management 
In the preceding section, we mentioned a variety of commands you can 
use in album windows to manipulate thumbnails. WebManager also 
includes commands that let you perform operations on the actual media 
files. Typically you’d do this kind of file management from the Browser 
window, but for convenience several commands are also available from 
album windows.  

 If an album thumbnail points to an original file that 
you’ve moved or deleted outside of WebManager, 
you’ll see a “broken link” symbol in its place. It’s up to 
you to delete these broken thumbnails by hand using the 
Delete Thumbnail(s) command. 

� NOTE: Keep in mind that Browser window thumbnails are pictorial 
equivalents of the file name—so any file command you carry out on 
a Browser thumbnail takes effect on the file itself!  
 



Managing Media Files    19 

 

 

Following is a summary of file operations you can carry out in the 
Browser window. Simply select one or more thumbnail(s) as described in 
“Selecting and Arranging Thumbnails,” then use the applicable toolbar 
button, menu command, and/or shortcut.  

RC   denotes that the item is also available from the thumbnail’s right-click 
menu, and A   means the command also works from album windows. 

File operations 

Using drag and drop 
To move one or more files, drag their Browser thumbnail(s) into 
a folder on the Explorer window’s Folders tab (or Windows 
Explorer). Ctrl-drag to copy. Dragging an album thumbnail into a 
folder or the Browser window copies the file. 

Edit/Cut  Shift+RC   (Shortcut: Ctrl+X) 
In the Browser window, marks the selected file(s) for deletion. 
The action is completed if a valid Paste command (for example, 
Paste into Folder or pasting into Serif PagePlus) is received.  

Edit/Copy Shift+RC   (Shortcut: Ctrl+C) 
In the Browser window, copies the selected file(s) to the 
Clipboard.  

Edit/Paste into Folder (Shortcut: Ctrl+Shift+D) 
Inserts one or more file(s) from the Clipboard into the current 
Folder, as displayed on the Folders tab and in the Browser 
window. Completes a previously issued Cut command. 
NOTE: Use the Paste into Album and Paste into New Album 
commands (see the next topic) to place a thumbnail for a file into 
an album. 

Edit/Delete File(s) RC    A    (Shortcut: Delete) 
In the Browser window or an album window, deletes the selected 
original file(s) and thumbnail(s). 
HINT: To bypass the Recycle Bin, press Shift+Delete. In an 
album window, you can choose Edit/Delete Thumbnail(s) (or 
press Delete) ro remove only the selected thumbnail(s), not the 
original file(s).  
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Previewing Content 
It’s easy to preview images via their thumbnails in either the Browser 
window or an album window. You can preview images either in the 
Preview window or in fullscreen view.  

To preview an image in the Preview window, click its thumbnail. If more 
than one thumbnail is selected, only the most recently selected image 
appears in the Preview window. 

 

Controls at the top of the Preview window, and additional right-click 
options, let you set image scaling preferences. To display each image 
within the window’s boundaries, select Auto Fit. This setting is also 
found on the right-click menu, along with a Restrict to Full Size option 
that (if checked) ensures larger images will shrink to fit but smaller 
images won’t expand beyond their 100% size. If unchecked, all images 
will scale to fit the window. 

To display each image at a fixed percentage, click Set Scale and adjust 
the slider to the desired factor (up to 200%). The adjustment factor will 
apply to each preview image, and images that are larger than the window 
will simply extend beyond it. You can also right-click the preview image 
and choose Double Size, Full Size, Half Size, or Quarter Size to set a 
specific scaling factor. If a preview image is larger than the window, you 
can drag it (using the hand cursor) to pan the image in the window.  

Fullscreen view 
Even if the Preview window isn’t open, you can preview one or more 
images—or the entire contents of the Browser window or an album 
window—in a fullscreen view. This is essentially a slideshow under 
manual control, without preset transitions and timing. 
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If you’re previewing selected images rather than a window-full, first 
select their thumbnail(s). (Ctrl-click to select additional thumbnails, or 
Shift-click to select a range including the initial selection.)  

Perhaps the simplest way to open fullscreen view is to click the  
View Fullscreen button. The button is context-sensitive, so if you have 
any thumbnails selected it will assume those are the ones you want to see. 
If no thumbnails are selected, it assumes you want to see the entire 
contents of the last window you were working in.  

There are several other paths to fullscreen view. You can right-click in a 
window and choose View Fullscreen; if you right-click a selected 
thumbnail, choose All (to include all files in the window) or Selected 
from the submenu. Another option is to choose View Fullscreen from the 
Actions menu and choose From Selection..., From Folder... (i.e. the 
current contents of the Browser window), or From Album... on the 
submenu.  

As in the Preview window, right-click options let you set scaling 
preferences. If you’re previewing multiple images in fullscreen view, you 
can control the image diplay via the right-click menu (choose Next or 
Previous) or by pressing the right or left arrow keys on the keyboard. 

To exit fullscreen view, press the Esc or Enter key, or right-click and 
choose Close. 

 



 

 
Acquiring Media Files 
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Whether you’re mainly interested in images, animations or video clips, 
WebManager is much more than just a shoebox for your collection. It’s 
designed to facilitate the more or less perpetual process of acquiring new 
files, previewing, sorting, and separating the digital wheat from the 
digital chaff.  

With the increasing popularity and lower prices of digital cameras these 
days, it won’t be long before traditional film cameras are relegated to 
antique shops. If you’ve already been bitten by the digital photography 
bug, you already know the rewards of seeing your results instantly on the 
screen. With WebManager, you can now index your entire archive, and 
then sort, sift, and edit to carve out an infinite variety of subsets. Sure, 
there’s work involved... but it’s the kind of effort most folks enjoy. And 
by next year at this time, there’s a good chance you’ll be thinking about 
converting all your old photo prints to digital form! 

Then there’s the World Wide Web—a veritable ocean of media files in 
all formats. Whether for business needs or personal projects, 
WebManager can help you tap this vast resource and zero in on exactly 
the content you’re seeking. You can search the entire Web while you just 
sit back and watch WebManager deliver the goods! 

Downloading Web Media 
The Explorer window’s Download tab automates the process of gathering 
media files from Web pages while assuring you full control over the end 
results.  

Downloading happens in three basic stages: selecting preferences, 
exploring pages, and collecting files. Downloading happens in three basic 
stages. Once you’ve set preferences for the search and a target page, 
WebManager begins exploring, following links outward from that 
starting page. Meanwhile, it builds a file queue—a list of every media 
file it finds that meets the criteria you’ve set—and a page queue—a list 
of pages remaining to be explored. The third stage is collecting: bringing 
the files back home to your computer.  

We’ll cover each stage in turn. 
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Selecting preferences 
First, you tell WebManager where to start the 
search, how wide a net to cast (the “search depth”), 
which criteria to use in selecting media files, where 
to store the downloaded files, whether to pause 
between the Exploring and Collecting stages, and so 
on.  

To begin, display the Explorer window and select 
the Download tab.  

Enter the URL of the target page where you want to begin searching. You 
can type the Web address, click the Favorites button to insert an 
address from your Internet Explorer Favorites list, or paste a 
URL from the Clipboard. (For example, if you’re already viewing the 
target page in your Web browser, you could simply copy and paste its 
address here.) 

Next, specify the folder where you want to store the files to be 
downloaded. Type the path or click the Browse button to locate 
the destination folder. 

On the Options tab, set up your basic search parameters. 

The Depth setting tells WebManager how many links away from the 
target page it should search. For example, if you set a depth of “0,” only 
the target page will appear in the page queue. A depth of “1” will include 
the target page plus pages one link away from it, and so on. 

Typically, you’ll have Filter checked in order to include or exclude 
certain media files based on file attributes (otherwise you may 
get lots of files you don’t particularly need). Click the Search 
Criteria button to set as few, or as many, attributes as required, then click 
OK. 
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Set this option... As follows... 

  Text in filename Type the text (which can be all or part of the filename) 
you want to locate.  

  File attributes To specify minimum and/or maximum values, check 
Min and/or Max and enter a cutoff value. 

  Format restrictions To restrict files to certain formats, click the Formats... 
button. In the dialog’s “file tree,” click  to expand a 
category and view subsidiary items. Click any item to 
place a  to include, or  to exclude, that item and all 
its subsidiary items. For example, simply placing  
next to “Animation files” is enough to exclude all the file 
types listed under that category: 

   

  Creation date Check From and/or To and select cutoff date(s). 

 
Check the Don’t leave server box to include only pages on the same 
server as the target page. This helps to restrict the search to a particular 
Web site and avoids getting diverted to externally linked pages. 

Check Pause before collecting if you want to pause the downloading 
process between the exploring and collecting steps. Pausing gives you 
extra time to review the list of files located by WebManager before 
actually downloading them. If the box is unchecked, exploring and 
collecting happen concurrently. You’ll probably want to learn more about 
this option (see the end of the “Exploring” section) before making up 
your mind. 

Once you’re done with the Options tab, 
select the Save tab and review preferences 
for local storage. Check Preserve 
hierarchy to have WebManager save files 
using a separate folder for each server it 
visits, with subfolders for each directory where files are stored on the 
server. This makes it easier to keep track of where the files have come 
from, and (depending on the original site’s structure) may preserve useful 
distinctions between various types of media files. If you leave the box 
unchecked, all files will be saved into one common folder. 
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The Don’t overwrite files setting applies if you’re downloading files to a 
destination folder that already contains files, and WebManager needs to 
save a new file that has the same name as an old one. If you’ve checked 
the box, a new filename will be generated automatically. If not, the old 
file will be overwritten. (You could safely overwrite, for example, if 
you’d previously downloaded files from a site, and were now checking 
that same site again for new files, using the same destination folder.) 
Note that this setting only applies to “collisions” between new files and 
those previously in storage. If duplicate filenames occur within the batch 
currently being downloaded, WebManager generates new names as 
needed, so the whole batch gets saved.  

Check Create album to create a new album for your downloaded files. 
With this option, URL (file and source page) information will be stored 
as Comments for each downloaded file. If unchecked, you can still create 
an album from the saved files later on, but the URL information will be 
lost. 

The Security tab is optional... Here you can enter a User name and 
Password if WebManager will need this information to gain access to 
the page(s) you’ve asked it to search. You can skip this step if no special 
logon is required. 

Now you’re ready to proceed with the next stage of downloading! 

Exploring pages 
Before proceeding, make sure you’re connected to the Internet, then click 
the Start button to begin the search. New controls appear that let you 
monitor and fine-tune the process, and you’re off and running. Basically 
here’s how the process works: WebManager first goes to the “target” 
Web page that you designated, and begins building a file queue—a list of 
every media file on that page that meets the criteria you’ve set. It will 
also put each of the hyperlinks on the target page into a page queue—
that is, a list of pages remaining to be explored. WebManager proceeds to 
visit each of these pages in turn, repeating the same steps until every link 
from the target page has been explored, out to the “depth” or number of 
links you’ve specified. 

Meanwhile, the progress bar and readout show how each process is 
going. The page queue values tend to fluctuate as each new page being 
explored will contribute new links. The file queue tends to build more 
rapidly, and then diminish gradually as files are collected. 
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� NOTE: By default, WebManager allows 20 seconds to make a 
connection to each page. If this Download Timeout value is 
exceeded, the search moves on to the next page. You can adjust this 
setting if necessary in File/General Preferences.... 

At any point, you can inspect either queue and make changes as needed. 
To edit the list of pages remaining, click Edit Page Queue. To edit the 
list of files remaining, click Edit File Queue. Clicking either button to 
edit a queue pauses that particular process.  

 

To rearrange items in a queue, select one or more items as shown in the 
illustration (use the Ctrl key for separate items or the Shift key to select a 
range) and then use drag and drop within the list. For example, you might 
decide to move certain images of greater interest to the top of the queue. 
To delete one or more selected items, press Delete. For example, if the 
file progress readout isn’t showing much activity, inspecting the page 
queue might allow you to remove some dull-sounding pages and move 
more promising ones to the top.  

If you want to conclude downloading early, click Stop. Assuming you 
don’t click the Stop button, exploration continues until the page queue is 
empty. At this point it makes a difference whether or not you checked the 
Pause before collecting option earlier on:  

♦ If you did check Pause before collecting, WebManager has so far 
refrained from actually collecting any files, and once the page queue 
is empty the File Queue window appears automatically, displaying 
the complete list of files to be downloaded. You can inspect it at your 
leisure and make any necessary changes as described above. Note 
that you cannot save the file queue for later review; it’s assumed 
you’ll inspect it now, make your edits, and then proceed to the 
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collecting stage. To start collecting files after the pause, click 
Collect. 

� NOTE: If you specified a Pause but then change your mind 
during the exploration stage, you can begin collecting (and skip 
the pause) by clicking the Collect button at any time during the 
exploration stage. 

♦ On the other hand, if you didn’t check Pause before collecting, then 
WebManager has been copying files to your computer concurrently 
while exploring, and collecting activity will just continue (read on) 
until the file queue is empty. 

 

Collecting files 
File collection—the process of actually copying files to your computer—
begins either as soon as you click the Start button, or (if you selected 
Pause before collecting, as just described) only after you click Collect.  

During collection, if you selected the Create album option, you’ll see 
thumbnails being added one by one into a new album window. 
Otherwise, the progress readout is your best indicator of how many files 
you’ve collected. 

As during exploration, you can edit the list of pages remaining (if any) by 
clicking Edit Page Queue. To edit the list of files remaining, click Edit 
File Queue. Clicking either button to edit a queue pauses that particular 
process. To suspend both exploration and collection, click Pause; then 
click Continue to resume downloading. 

Click Stop at any point if you want to conclude downloading early. 
Assuming you don’t click the Stop button, collecting will continue until 
the file queue is empty, at which point the Download tab reverts to its 
initial state—and hopefully you’ve collected exactly the files you were 
looking for!



 

 
Presentations  
and Output 
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It’s probably safe to say that images exist in order to be seen. So whether 
you create your own images (for example, using a digital camera) or just 
collect them (for whatever purpose), putting the pictures on display is 
almost certain to be an important goal. The same holds true for other 
media. 

Web galleries are an engaging and convenient method of presenting 
digital content—and truly easy to achieve with WebManager. Pick a 
preferred layout, then customize details such as color and border, to 
produce an HTML-based showcase for your images and multimedia.  

And of course, for passing around at the next family gathering, nothing 
beats traditional paper-based photo prints. Whatever the occasion, you’ll 
find that WebManager supports all your image printing needs.  

Publishing a Web Gallery 
Web galleries are a great way to present media files to a wider 
audience—typically over the World Wide Web, but just as easily via disk 
media. They’re convenient because they let viewers peruse a thumbnail 
index of what’s available and make selections without having to 
download or open all of the files.  

WebManager provides a wide range of preset page templates and styles 
that let you quickly compose a Web gallery from any selection or full 
window of file thumbnails (for multimedia files as well as images). You 
can customize the layout as needed and then publish the gallery to a 
specific folder, either on a Web server or a local disk. Either way, 
WebManager takes care of building the HTML pages and exporting the 
designated files.  

Begin by deciding which file you want to publish, and selecting the 
thumbnail.  

Choosing a layout 
To make your gallery layout choices, click the Publish to 
Web button. If you have thumbnails selected, these will be 
published; if not, the gallery will include the entire contents of the last 
window you were working in. Alternatively, you can right-click in a 
window and choose Publish to Web; if you right-click a selected 
thumbnail, choose All or Selected from the submenu. Or choose Publish 
to Web from the Actions menu and then From Selection..., From 
Folder... (i.e. the current contents of the Browser window), or From 
Album.... 
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On the right side of the Edit Web Page Layout window, the two scrolling 
lists present samples of Templates—alternative ways of arranging pages 
and images—and Styles—different combinations of the various detailed 
elements that comprise each page (background color, thumbnail cell 
borders, and so on). The window serves as a “live” preview area that lets 
you navigate by clicking thumbnails, as well as try out the various 
choices and customize them as needed. 

The first time you try publishing, you’ll certainly want to explore each of 
the various templates. One basic layout choice is between a single-page 
scheme where thumbnails scroll alongside a preview region, and a multi-
page scheme with an index page for thumbnails plus a separate page for 
each image. Click any template sample to try it out, and click the preview 
thumbnails to test the navigation.  

Use the  Back,  Forward,  Refresh, and  Home 
buttons as needed to traverse links or update page content. 

Once you’ve settled on the template you prefer, proceed to selecting a 
style. Click in the Styles list (or press the arrow keys to step through the 
choices) to preview each sample. Don’t be distracted by color changes—
remember that every element is customizable! The trick is to find the 
layout that will require the least additional fine-tuning. 

Perhaps you’ll be lucky and hit upon a preset style that’s precisely what 
you’re looking for. More likely, there will be some elements of the layout 
you’ll want to adjust at this point. Don’t be alarmed... but the number of 
possibilities is quite vast, given the customizability of the underlying 
HTML and style sheet code. 
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The good news is that you don’t need to know a thing about HTML to 
make changes. As you move the mouse around the preview window, 
watch as the Hintline at the bottom identifies customizable page 
elements. Just right-click an element and choose the property you want to 
modify, or choose items from the window’s Edit or Style menu.  

 

The dialogs (for example, the Thumbnail Style dialog as shown above) 
provide lots of choices, and each starting layout is different—so a “try it 
and see” approach will work best. Here’s a summary table of attributes 
you can set:  

Use this command... To adjust these attributes... 

Edit menu (or right-click):  

 Thumbnail Size... Width and height of thumbnails  

 Description... Wording style of thumbnail caption 

 Description Font... Text attributes of thumbnail caption 

 Table Layout... Rows and columns, cell spacing, table width, 
thumbnail stretch, description position 

Style menu (or right-click):  

 Thumbnail Style... 
Thumbnail Cell Style... 
Description Cell Style... 
Table Style... 
Body Style... 

(for the designated element) 

Border style, border width, margin width, 
padding width, border color, background 
image or color, description cell alignment 

 



Presentations and Output    35 

 

Publishing 
Once you’ve made your final decisions regarding the gallery layout, 
you’re ready to publish—either to a local folder or to the Web. Either 
option is just a mouse-click away. 

� NOTE: Before publishing to the Web, make sure you’ve gathered 
basic information from your service provider, as detailed in online 
help (see the “Publishing Web galleries” topic). 

To publish to a folder, simply click the Publish to Folder button.  In the 
dialog, designate a target folder, and click OK. That’s it! To preview the 
pages, use your Web browser to open INDEX.HTML. 

To publish to the Web, click the Publish to Web button. In the dialog, 
enter the FTP address of your Web host and your pre-assigned Username 
and Password. Be sure to enter the password exactly as given to you, 
using correct upper- and lower-case spelling, or the host server will not 
recognize it. If publishing to your root directory, you can leave the Folder 
box blank. 

 

When you click OK, WebManager seeks an Internet connection or 
establishes a new one, and connects to the remote server. With some 
online services, you’ll need to use the service’s proprietary log-on 
software to establish a connection. You’ll see a message when all files 
have been successfully copied. Now you’ll be able to see your page(s) 
“live” on the Web! Point your Web browser to the URL that includes the 
path to the host server plus the folder to which you published. 
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Working with gallery pages 
Whether you publish to a folder or to the Web, the set of exported files 
typically consists of a main page, with a frameset page (INDEX.HTML) and 
one or more source pages (e.g. INDEX2.HTML), a style file (THUMBS.CSS), 
plus two folders (/IMAGES and /THUMBS) containing the media files and 
thumbnail images, and a subfolder with a page for each full-size image. 
Thus, the gallery constitutes its own mini-Web site and anyone who 
browses to INDEX.HTML will be able to view it. 

If you’ve included thumbnails for multimedia files, the original files are 
exported (just like image files) when you publish the gallery. Clicking the 
gallery thumbnail for a multimedia file triggers playback of the original 
file. 

If you plan to incorporate the gallery into an existing site, it’s easy 
enough—but before publishing, check for duplicate file or folder names. 
(For example, you wouldn’t want to overwrite your existing INDEX.HTML 
page with the WebManager page of the same name!) A safe bet is to 
publish the whole WebManager gallery to its own separate subdirectory, 
so no conflicts arise. It’s fine to rename the gallery’s INDEX.HTML (say, as 
GALLERY.HTML), but don’t rename anything else unless you’re prepared 
to repair links within the source code. More proficient users wishing to 
integrate gallery files with an existing site structure can use Publish to 
Folder, rename and test locally as needed, and then use a separate FTP 
program to upload the files. 

When you publish a gallery, WebManager by default includes metadata 
tags that, while unseen by viewers, allow search engines to identify page 
content and build descriptions. On the Web Publishing tab of the 
File/General Preferences... dialog, you can set metadata options 
including which WebManager text (from thumbnail keywords, album 
Notes, and/or thumbnail Comments) search engines should use. You can 
specify how WebManager should export image files in non-Web-
compatible formats (you can convert these to GIFs or JPGs, or leave them 
as is). 

WebManager Web galleries are designed to take advantage of the 
flexibility afforded by Cascading Style Sheets. If you prefer a hands-on 
approach, you can edit the THUMBS.CSS file and create your own 
alternative templates for Web publishing. 
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Printing 
Beyond standard printing capabilities, WebManager affords versatile 
layout features that let you scale and arrange images on the printed page, 
customize text captions, and add headers and footers. It’s easy to print 
anything from a single image to multiple sheets with hundreds of 
thumbnails. 

You can print the entire contents of a window, or just a subset of images. 
To print a subset, begin by selecting the individual thumbnails. Ctrl-click 
to select separate thumbnails, or Shift-click to select a range. 

To start printing, click the  Print button. If you have any thumbnails 
selected, these are the ones that will be included. If no thumbnails are 
selected, WebManager will include the entire contents of the window you 
were last working in. Alternatively, you can right-click in a window or on 
a selected thumbnail and choose Print... (if you right-click a selected 
thumbnail, choose All or Selected from the submenu), or choose Print... 
from the File menu and then From Selection..., From Folder... (i.e. the 
current contents of the Browser window), or From Album.... 

 

The Print dialog incorporates four tabs to help you tailor the output 
precisely to your needs. The preview region at the right displays the page 
margins and a reduced view of each page to be printed. Use the 
navigation and zoom buttons below the preview to step between pages 
and preview at various magnifications. The Print Setup tab lets you 
define standard printer settings, print range, and number of copies. 
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Whether you’re printing one image or many, use the Layout and Style 
tab to select how the pictures will scale to the printed page. You can 
define a grid using the Rows and Columns sliders, ranging from a 1x1 
layout for a single image to 16x16 for a sheet of tiny thumbnails. 
(WebManager automatically adjusts the number of pages.) The Choose 
Style drop-down list lets you select a preset combination of layout 
attributes.  

To customize particular page elements (such as the background or border 
of image cells or description cells), use the schematic layout region. Click 
the item you want to adjust as shown below, and make your selections 
while watching the preview region. 

  

Use the Thumbnail Text tab to select a wording style and define text 
attributes for caption text. To remove captions entirely, select “Blank” 
from the list. Finally, use the Headers and Footers tab to define 
optional text and/or page numbers in these regions at the top and bottom 
of each page. 

When you’re done setting print options, click OK to proceed with 
printing.  

 

    

Header 

Image (border) 

Image Cell 

Caption Cell 

Footer 


